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Introduction
This document will provide a basic reference manual of the BAND-GUI. BAND-GUI is the Graphical User
Interface for the ADF-BAND package.

If you are new to the BAND-GUI we advise you to study the BAND-GUI tutorial.

The BAND-GUI modules
The BAND-GUI consists of several modules:

ADFjobs

This utility ($ADFBIN/adfjobs) manages your jobs: run a job on your local machine or on remote
machines. It also serves as a interface to all files belonging to your job, and it servers as a convenient
launcher of the other ADF-GUI modules.

BANDinput

A utility program ($ADFBIN/bandinput), which enables users to easily create BAND jobs. You can use
BANDinput to define your periodic structure (geometry), and to set details of your BAND job using an
easy-to-use graphical user interface. BANDinput will generate the complete job script for you. This script
takes care of running BAND.

ADFview

A simple program ($ADFBIN/adfview) that displays volume data, such as the electron deformation
density and orbitals.

BANDstructure

This program ($ADFBIN/bandstructure) shows a plot of the electronic band structure

ADFdos

This program ($ADFBIN/adfdos) shows the DOS graphs for BAND. Both the full DOS and partial DOS is
available: you can select which atoms (or even which functions on some atom) should participate in the
DOS.

ADFmovie

This program ($ADFBIN/adfmovie) shows the progress of a geometry optimization

ADFtail

A minor ADF-GUI utility ($ADFBIN/adftail) that will just show the contents of a text file, updating when
the text file grows (like the UNIX tail -f command). It is used to monitor the 'logfile'. The progress of an
BAND (and ADF) calculation is always written to this file.

ADFoutput

A output browser ($ADFBIN/adfoutput) for the output generated by BAND. It displays the full output file,
and provides short-cuts to the most common things of interest (including properties).

GUIprefs
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All preferences that are being used by the ADF-GUI and the BAND-GUI.

The SCM (logo) menu
All ADF-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small
SCM logo. In this menu all ADF-GUI and BAND-GUI modules are listed, as well as COSMO-RS and some
general commands. Some modules are specific for the ADF-GUI or the BAND-GUI, these start with ADF or
BAND respectively. The other modules may be used with both the ADF-GUI and the BAND-GUI.

You can easily switch between the different modules of the ADF-GUI using this menu:

• ADF Input: activate ADFinput
• ADF Levels: activate ADFlevels
• COSMO-RS: activate COSMO-RS
• BAND Input: activate BANDinput
• BAND Structure: activate BANDstructure
• View: activate ADFview
• Movie: activate ADFmovie
• Logfile: activate ADFtail
• Output: activate ADFoutput
• Spectra: activate ADFspectra
• Dos: activate ADFdos
• Close: close all ADF-GUI modules for the current or (in ADFjobs) selected, calculation
• Close All: close all ADF-GUI modules at once
• Preferences: activate GUIprefs, set preferences for all modules
• Jobs: activate ADFjobs

When you use the SCM menu while some file is connected to the current ADF-GUI module, the selected
ADF-GUI module will be activated showing data belonging to the same calculation. The title bar of any ADF-
GUI module shows which file is connected, if any. Thus, you can easily switch between viewing the logfile,
output, input, orbitals, etc, all belonging together.

When you use the SCM menu when no file is connected (the title bar just shows the name of the module),
the selected ADF-GUI module will be started without file.

Selecting a menu command from the SCM menu while the control key is pressed down will start the
selected module with no file. An alternative in ADFjobs is to clear the selection first (using the ESC key).

On most platforms you can tear off the SCM menu by selecting the dashed line at the top of the menu.

Automatic bug reports
Please enable the automatic mailing of bug reports. These reports contain detailed information about the
internal state of the ADF-GUI module having some problem, but do not contain personal information.
Information about the structure of your molecule is included.

You can enable this by setting the global environment variable SCM_ERROR_MAIL, for example in your
login script:

SCM_ERROR_MAIL=errors@scm.com
export SCM_ERROR_MAIL

This will ensure that the bug report will be sent to the e-mail address you specify. If you specify your own e-
mail address you can see exactly what kind of information is contained in the error report.
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Your comments and bug reports are very welcome. Please send them to support@scm.com, or use the
'Feedback' menu command from the 'Help' menu of the ADF-GUI modules.

Environment Variables
In the following table the environment variables that are specific for the ADF-GUI are listed:

Name Meaning Default Value
SCM_ERROR_MAIL e-mail address for error reports no error e-mail sent
SCM_GUIRC location of the preferences file $HOME/.scm_guirc
SCM_TPLDIR location of the templates directory none (no extra templates loaded)
SCM_STRUCTURES location of the structures directory none (no extra structures loaded)
SCM_RESULTDIR location of the results directory none (current directory used)

DISPLAY X-window display to use required (for all X11 programs) except on
Windows

SCM_MOPAC command to start MOPAC none (default script $ADFBIN/
mopac.scm will be used)

SCM_QUEUES path to the dynamic queues directory none (ADFjobs will search the remote
$HOME/.scmgui)
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Mouse Interaction
Rotate, Translate and Zoom
In the modules that provide a 3D view of your molecule (currently ADFinput, ADFview, ADFmovie and
ADFdos) you can rotate, translate and zoom using the mouse.

Drag with the mouse: press a mouse button, and move it while holding it down. A one-button mouse button
is the same as a Left mouse button. Which mouse button, and which modifier key you press at the same
time, determines what will happen:

Rotate Left
Rotate in-plane Ctrl-Left
Translate Middle, or Alt-Left
Zoom Right, or Command-Left (drag up or down)

The rotate, translate and zoom operations change how you look at the molecule. They do not change the
coordinates. When you Right or command-Left without dragging the mouse, a pop-up menu will appear.

In ADFinput operating with the mouse on the selection will move the selection only. In that case the
geometry of your molecule (and thus the coordinates) will change. Zooming the selection will move it
perpendicular to the screen. You operate on the selection by starting the drag operation with the mouse
above a selected object.

In the View menu you can select either 'Mouse as trackball' or 'Mouse as joystick'. If 'Mouse as trackball' is
selected, you need to drag with the mouse (move the mouse with a button pressed down). If 'Mouse as
joystick' is selected you just need to press and keep the button pressed down. The direction of movement
etc will depend on the position of the mouse with respect to the center of the 3D view area. Note that 'Mouse
as joystick' disables some pop-up menus.

Selecting
In the modules that provide a 3D view of your molecule (currently ADFinput, ADFview, ADFmovie) you can
make selections using the mouse.

Click on an object: make a new selection with it

Click in space: clear selection

Shift-Click on object: add or remove it from the selection

Shift-Drag in space: add all objects within the rectangle to the selection

Pop-up menus: Select all similar elements or all bonds by using the pop-up menus

In some modules there are additional ways to select objects using menu commands. Furthermore, one can
select atoms from the list in the coordinates window.
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Shared Menus
Pop-up menus
In many cases pop-up menus are attached to objects (atoms, bonds, empty space, peaks, levels, ...) that
allow you to do something with that particular object. To get the pop-up menu (a one-button mouse button is
the same as a Left mouse button):

Press and hold the Right mouse button on the object: the pop-up appears almost directly.

Press and hold the Left mouse button on the object: the pop-up appears after a small delay.

ADFinput, ADFmovie and ADFview share the following pop-up menu commands, note that some programs
extent the pop-up menu with some additional commands.

Pop-up menu on atom X

Atom Info: name, charges etc.

Use the checkboxes to select what info per atom to show. The atom name, and possibly some other things.

When a .t21 result file is open in ADFview or ADFmovie, some scalar properties might be available. For
example, you can show the Mulliken Charge in that atom info label, some other atomic charge, or the
electrostatic potential at the nucleus. The list of available properties will automatically be constructed,
depending on the kind of information in the result file.

The command will be applied to the current selection, if any. If nothing is selected, it will be applied to the
atom on which the user clicks.

Color Atoms By...

Select the property that will be used to define the atom colors. If you use a scalar property, you can
optionally set the scalar range to be mapped to colors, and you may select to show a color legend.

Atom Radius From...

Select the property that will be used to define the atom radius. If you select a scalar property the absolute
value of that property will be used. Next it will be clipped to the min - max value as defined in the
preferences (via the SCM menu).

Geometric Info

Depending on the number of atoms selected, subcommands are available to show distances and angles, or
to hide them.

Info Style

Select the size and colors of the Atom Info labels.
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Atom Radius

Make the radius of the selected atom(s) bigger or smaller, for display purposes only.

Hide all X atoms

Hide all atoms of type 'X'.

Select all X atoms

Select all atoms of type 'X'.

Select all atoms

Select all atoms (note that the bonds will automatically also be selected).

Pop-up menu in empty space

Atom Info: name, charges etc.

Use the checkboxes to select what info per atom to show. The atom name, and possibly some other things.

When a .t21 result file is open in ADFview or ADFmovie, some scalar properties might be available. For
example, you can show the Mulliken Charge in that atom info label, some other atomic charge, or the
electrostatic potential at the nucleus. The list of available properties will automatically be constructed,
depending on the kind of information in the result file.

The command will be applied to the current selection. If nothing is selected, it will be applied to all atoms.

Color Atoms By...

Select the property that will be used to define the atom colors. If you use a scalar property, you can
optionally set the scalar range to be mapped to colors, and you may select to show a color legend.

Atom Radius From...

Select the property that will be used to define the atom radius. If you select a scalar property the absolute
value of that property will be used. Next it will be clipped to the min - max value as defined in the
preferences (via the SCM menu).

Geometric Info

Depending on the number of atoms selected, subcommands are available to show distances and angles, or
to hide them.
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Info Style

Select the size and colors of the Atom Info labels.

Show bonds to hidden atoms

If you hide some atoms, for example the hydrogen atoms, the bonds to these atoms may still be hidden. Use
this command to show those bonds.

Hide bonds to hidden atoms

If you hide some atoms, for example the hydrogen atoms, the bonds to these atoms may still be visible. Use
this command to show those bonds.

Default atom properties

Reload the default atom properties (colors, hidden etc) as stored in the preferences for the ADF-GUI.

Select All Atoms

Select all atoms (note that the bonds will automatically also be selected).

Select All Bonds

Select all bonds. The atoms will not be selected.

View Menu
The 'View' menu is also shared by ADFinput, ADFmovie, ADFview and ADFdos. It will contain at least the
following commands (note that some programs might extend the 'View' menu with other commands):

Reset View

When you use the 'Reset View' menu command, the translation, zoom and rotation settings will be adjusted
such that the entire molecule is visible. The center of your molecule will be the new rotation center.

Use it for example when you translate the molecule 'out of view'.

View Direction

Rotate the molecule such that you view along the specified axes.

Parallel Perspective

Check to get a straight parallel perspective. This will not take the distance into account, and may be useful
with crystals for example.
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Fly to selection

Zoom to the center of the current selection (or of the whole molecule if nothing is selected). The zooming
occurs 'real life', as if you are flying to that point. The zoom point will be the new center of rotation.

Align screen

First select three atoms defining a plane (thus, not three atoms on a line ...).

Next, use the 'Align Screen' command to rotate your molecule such that the plane defined is parallel to the
screen.

Mouse as

Determine how your mouse works:

Trackball: you rotate etc by dragging around the screen. This is the default, and most intuitive, mode.

Joystick: you rotate etc by pressing down a mouse button off-center, and keep it pressed down. Your
molecule will rotate, translate etc in the direction of your mouse button (with respect to the center of the
drawing area). Since the press-and-keep-down conflicts with pop-up menus, they will be disabled.

Anti-alias

Use the anti-alias technique to improve the quality of the pictures. Especially sharp edges will look
smoother.

It works very well, but is rather time-consuming to calculate. As a result everything will be very very slow.
For that reason we advise you to first increase the resolution of the picture to be saved. Next, only when you
want to prepare an extremely high-quality picture for a presentation (and have plenty of time ...), you might
in addition turn on anti-aliasing.

As anti-aliasing works my mixing in the background color to get smooth edges, you cannot change the
background color in a saved picture. If you would wish to do so (for example, make the background
transparent), you should not use anti-aliasing.

Axes

Show axes. The red line is the X-axes, the yellow line is the Y-axes, the green line is the Z-axes.

Molecule Ball &Sticks

Molecule Resolution

Set the resolution of the molecule display (the number of triangles used to represent the atomic spheres and
the bonds). If you have a big molecule and a low-end graphics card you can speed up display by choosing
'Low'. For high-end graphic cards you might not see a significant difference.
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Balls And Sticks

Show the molecule as balls and sticks

Using the regions panel you can set this option per region.

Sticks

Show the molecule as sticks only (that is, with the atoms hidden).

Note that this will make editing much harder as you cannot click on an atom to select it.

Using the regions panel you can set this option per region.

Wireframe

Show the molecule as a simple wireframe only.

Note that this will make editing much harder as you cannot click on an atom to select it. However, the
display is much faster so it is efficient to use for big molecules.

Using the regions panel you can set this option per region.

Show Bond Type

Use different graphics for single, double, triple and aromatic bonds if checked. If not, all bonds will be
visualized as a single bond no matter what bond type it is.

Color Bonds By Atoms

Bonds will have two colors: one half matching the first atom bonded to, the other half matching the other
atom bonded to.

Bigger, Smaller

Change the size (radii) of the balls and sticks used to display the molecule. Note the convenient shortcuts
(control - and control +, or command - and command +).

Background

Select the color of the background.

Periodic

This let you control aspects that have to the with periodic systems.
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Repeat Unit Cells

With this option on the unit cell will be repeated to give a better impression of what the solid looks like. When
the GUI becomes unresponsive you can turn it off.

Unit Cell Range

When you have chosen to repeat the unit cell, this options controls the number of copies.

Show Lattice Vectors

A toggle to turn on or off the display of the lattice vectors.
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BAND-GUI modules
ADFjobs

See the ADF-GUI ADFjobs documentation.

BANDinput

Introduction

BANDinput is a utility program ($ADFBIN/bandinput), which enables ADF-BAND users to easily create
BAND jobs. You can use BANDinput to define your molecule (geometry), and to set details of your BAND
job using an easy-to-use graphical user interface. BANDinput will generate the complete job script for you.
This script takes care of running BAND programs as required. You can also use BANDinput to run these
script files on your local machine in the background.

Starting BANDinput

If you have installed the ADF package correctly, the bandinput command is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the ADFinput program with the
following command:

bandinput [filename]

The filename is optional. BANDinput only handles files that were created by BANDinput before, which have
a .band extension.

An alternative method to start BANDinput: select the Input command from the SCM menu.

Under windows you can start BANDinput by simply double-clicking the icon on the desktop.

Panels

The BANDinput window has two main areas: on the left is the molecule (or crystal) editor, and on the right
are the panels.

The panels on the right allow you to set up your BAND calculation. You can switch between different panels
using the pull-down menu across the top of the panels, or by using the menu commands from the main
menu.
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Menu Commands

File menu

New

Same as quitting BANDinput and starting again without specifying a file name.

Open...

Open an existing BANDinput file (with .band extension).

Import Coordinates...

Use this menu command to import the geometry of your molecule from file. The various formats are derived
from the file extensions.

The truly periodic formats recognized are

1. .runkf: Band result file.
2. .band: BANDinput file.
3. .cif: The Crystallographic Information File format.
4. .dmol: Files from the DMol program.

In addition you can also import molecules (i.e. without lattice information)

1. .t21: If you import coordinates from a .t21 file note that the extension must be .t21. A name like
'TAPE21' will not work. Also, bond information and lattice vectors are not present, just the
coordinates are imported and bonds will be guessed (and no distinction will be made between
different kinds of bonds).

2. .mol: Importing from a .mol file will also give you both the coordinates and bond information of the
file, but not the lattice vectors.

3. .xyz: Importing from a text file is rather flexible: BANDinput needs three real numbers next to each
other. These will be interpreted as x, y and z coordinate. One additional integer or the abbreviation
of an element is also needed to identify the kind of atom.

Directly after the 'Import Coordinates...' command the newly imported atoms are selected. A useful trick is to
group them. This makes it easy to reposition them with respect to other atoms that may already be present,
remove the automatically guessed bonds, or use other operations on the newly imported atoms and bonds.

Export Coordinates...

Export the current geometry (unit cell only) as a simple space separated list of element name and xyz
coordinates. The number of lines will match the number of atoms. No bond information is written to the text
file.

You will be prompted to specify a file name.
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Save

Save the current state of what is present in BANDinput. If you have not saved before, BANDinput will ask
you to specify a file name.

Not only the .band file will be saved, but also a matching .run file which is a run script corresponding to your
input.

Save As...

Save the current state of what is present in ADFinput in a file with a name of your choice.

Not only the .band file will be saved, but also a matching .run file which is a run script corresponding to your
input.

Revert...

After opening a .band file with BANDinput and making some changes, you can use the 'Revert...' command
to undo all your changes. It is the same as quitting without saving, and opening the same file again.

Save Picture...

Save a picture of your periodic structure (only the drawing area with your structure, no input options) in a file.

The format used to save your picture is determined by the extension of the file name you specify. If you do
not specify a known extension, it will use the standard picture format as specified using the 'Default Picture
Format' menu.

Default Picture Format

Use the submenu to select the format to use when saving a picture.

Note that this is just the default to use, the user specifies the format with the extension. When the extension
is not recognized (or when no extension is specified) the default format will be used.

Run

Start the BAND program as selected in all the input options.

This is done by telling ADFJobs to execute the saved run script. If you have made changes in BANDinput,
you will first be asked to save the changes. Just as the Save menu command, this will also save the run
script (with the .run extension). Next the run script is executed on your local machine, and ADFtail is started
to monitor the progress of the calculation using the logfile.
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Quit

Stop BANDinput, ask you to save changes if you made any.

Edit menu

Undo

Undo the last operation. It uses a stack of many operations, so you can use the Undo command repeatedly.

Redo

If you have undone some operation, you can use Redo to do it again.

Cut

Make a copy of the current selection, and next delete the original.

Cut, Copy and Paste work within text fields, and with atoms and bonds in the drawing area.

Copy

Make a copy of the current selection.

Cut, Copy and Paste work within text fields, and with atoms and bonds in the drawing area.

Paste

Paste the current copy.

Cut, Copy and Paste work within text fields, and with atoms and bonds in the drawing area.

Clear

Delete the current selection.

Group

The currently selected atoms and bonds will be grouped together. Once grouped, if you select any of the
group members the whole group will be selected.

You may nest groups if you wish, the original group structure will be remembered.
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Ungroup

Remove the grouping of the currently selected items.

If you ungroup a nested group, only the top grouping will be removed and you will recover your original
groups.

Set origin

Translate all atoms such that the selected atom will be the new origin. If nothing is selected, the center of all
atoms will be the new origin. If more than one atom is selected, the center of the selected atoms will be the
new origin.

Define Super Cell...

In some occasions you want to define a larger unit cell. This menu item invokes a dialog which let you define
a "Super Cell Transformation". This simply defines the new lattice coordinates in terms of old ones (along
the rows of the matrix).

Map Atoms To Unit Cell...

In the definition of a crystal it is always allowed to add a lattice displacement to the atomic coordinates. This
option tries within this degree of freedom to get the atomic positions within the unit cell. The algorithm is so
that eventually the natural coordinates will be between -0.5 and 0.5. (This unit cell definition is different from
the Wigner-Seitz cell.)

Bond Lengths constrained

When creating new atoms bonded to existing atoms, BANDinput will constrain the bond length to the
textbook value.

If you do not wish this to happen, select this menu command to toggle this behavior.

Add Bond

Create a bond (if possible depending on the number of free connectors) between two selected atoms.

Add Hydrogen

The 'Add Hydrogen' menu command will add hydrogen atoms to your structure until every connector is
connected. The number of connectors and the number of lone pairs determine the geometry. For example,
the Oxygen atom has four connectors and two lone pairs in a tetrahedral arrangement.

The hydrogens will only be added to selected atoms, or to your whole molecule if no atoms are selected.
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Remove Hydrogen

The hydrogen atoms will be removed from your molecule.

If you have selected part of your molecule, only hydrogen atoms in your selection will be removed.

Fuse Atoms

Fuse atoms that are very close together (in 3D space) to a single atom. If atom types differ, one of the types
will randomly be chosen.

Select All

Select all atoms and bonds in your structure.

Select Molecule

Select all atoms and bonds that are somehow connected to the current selection.

Select Connected

Select all atoms that are directly connected (by one bond) to the current selection.

Guess Bonds

Roughly guess what atoms are bonded together, depending on the distance between the atoms compared
with text book values. The bond type is currently always set to single, so you probably need to make some
changes.

Only BANDinput uses the bond information. The BAND program itself does not use any of the bond
information.

Bonds will only be guessed for the selected atoms, leaving the remaining part of your molecule unchanged.
If nothing is selected, bonds will be guessed for your whole molecule.

Remove Bonds

Remove all bonds in the current selection, or in your whole molecule if nothing is selected.

View menu

See Standard View commands.
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Model menu

The 'Model' menu gives access to the first group of input panels on your right-hand side. They roughly
specify your system.

You can also use the pull-down menu at the top right side (above the panels) to get to these panels.

Properties menu

The 'Properties' menu gives access to the second group of input panels on your right-hand side.

Details menu

The 'Details' menu gives access to the third group of input panels on your right-hand side. You can use
these to specify many details that are typically not needed. Expert users will get access to more BAND
options with these panels. You can use the 'User Input' Menu to add BAND options that are not available
(yet) in the BAND-GUI directly.

You can also use the pull-down menu at the top right side (above the panels) to get to these panels.

Help menu

The help menu provides an easy way to get to information about the BAND-GUI. It will start a browser on
your local machine, and connect to the SCM web site to get information.

Buttons and Tools

The button bar contains a number of tools and buttons:

From left to right the meaning is

Button Description Keyboard
shortcut

1: Select Tool Used to select, and to rotate, translate or zoom (with modifier
keys or mouse buttons). Esc

2: Atom Tools

C-tool, O-tool, N-tool, H-tool: atom-tools used to
• create a C, O, N, or H atom,
• change an existing atom,
• create bonds between existing atoms.

C, O, N,
H, Cl, S &
P

3: Element Tool A tool used to
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• create any atom (from the periodic table that will pop-
up),

• change an existing atom,
• create bonds between existing atoms.

4: Structure Tool
Build crystals in one of the following ways

• Access predefined structures from a small database
• Define a crystal from space group information

5: Slice Tool Cut slabs from any 3D crystal

6: View Directions

Change to the default view
• along the z-axis
• along the x-axis
• along the y-axis

7:Perspective Toggle between drawing with and without perspective
8: Periodic display Toggle between showing a single unit cell and showing a couple

of them.

Getting and changing geometry details

If you select 2, 3 or 4 atoms some geometry information will be presented at the bottom of the screen:

• 2 atoms: distance
• 3 atoms: angle
• 4 atoms: dihedral angle
• 5 atoms: angle between two planes

Often you can also change the information displayed. The geometry of your molecule will be updated
accordingly. This is not always possible: ring structures make it impossible since BANDinput does not know
how to change other bonds and angles. In such a case you might temporarily remove a bond, fine-tune your
geometry, and finally recreate the bond you removed. The planes of the plane angle are defined through (in
order of selection) atoms 1, 2 & 3 and atoms 3, 4 & 5. The order of selection is important in all cases.

Keyboard shortcuts

Many tools and menu commands have keyboard shortcuts associated.

For menu command shortcuts, the shortcut is listed in the menu. On most UNIX systems (including Linux)
you need to use the control key together with some letter. On a Macintosh (running locally) you need to use
the command key together with a letter.

The following table lists the other keyboard shortcuts. Just press the indicated key without any modifier keys:

Key Function
Esc Select-tool (end other tool)
C C-tool
O O-tool
N N-tool
H H-tool
P P-tool
S S-tool
backspace Delete selection
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delete Delete selection

Presets and Defaults

All input options have default values. However, the default values depend on the main task you have
chosen, and on further properties you may select to calculate. BANDinput uses presets that are simply a
collection of input values to be used together as defaults.

BAND only has a few presets, Accurate and Fast, which set the basis set and (K-space) integration
accuracy. You may also define your own templates.

Use a Preset

Select the preset you want to use from the Preset menu, located in the main input options area.

All or some input values will change to the values specified in the preset you select.

Revert to preset values

If you want to undo your changes and get back to the default values as specified in the current template,
simply select the template again from the Template menu.

Color Code

The input fields use a color coding to warn you they have been modified:

• No special color: the field has its original default value.
• Yellow: the field has been changed by the user (only).
• Green: the field has been changed by the preset (only).
• Red: the field has been changed by the preset, and next by the user.

The pull-down menu that you use to switch between panels uses a similar color-coding to point you to fields
that have been changed:

• No special color: all fields in the panel have their original default value.
• Yellow: some fields have been changed by the user.
• Green: some fields has been changed by the preset.
• Red: some fields has been changed by the preset, and some (possibly also) by the user.

Make your own presets

It is very easy to make your own presets, collecting all or a few default values for the typical jobs you like to
perform.

When the SCM_TPLDIR environment variable has been set, BANDinput will look for user-defined presets
(when starting up) in the directory $SCM_TPLDIR.

Thus, to use your own presets first set up your preset directory if you have not already done so:

• make a directory in which to store your presets
• set the SCM_TPLDIR environment variable to point to this directory
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Next, in BANDinput (restart it if it was already running):

• select the preset to start with (or None if you wish to start with an empty preset)
• edit all the fields as you would like them to be stored in a preset.
• select 'Save as (Full) Preset' from the Preset menu
• specify a file name, ending with '.tpl'
• click on Save.

If you now check your Preset menu you will find a new entry.

The name of the preset is the file name you have chosen, but without the .tpl extension.

The difference between a Full Preset and a 'normal' Preset is that a Full Preset will save all input options,
and a 'normal' preset will save only the yellow or green fields (options that have been changed by the user
or by the active template).

If you wish to store only fields that you have changed yourself in the preset, make sure you start with the
None preset.

Defaults

The default values that are shown when you start BANDinput are generated as follows:

• Use the Defaults preset supplied by SCM
• Use the Defaults preset that the user has defined, if any
• Use the 'None' preset

Thus, you can change the defaults by saving a preset called Defaults.tpl in your SCM_TPLDIR.

Molecule Editor Tricks

Selecting

You can make or change a selection using the mouse or using menu commands.

Making a selection with the mouse: see Selecting

Making a selection with a menu command: see Edit Menu

Pop-up menus: Select all similar elements or all bonds by using the pop-up menus.

Delete an atom

Select the atom (click on it), and press the Backspace key.

Delete a bond

Select the bond (click on it), and press the Backspace key.
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Delete the selection

Make your selection, and press the Backspace key.

Make a bond

Take one of the atom tools.

Next click once on the first atom you want to connect. You will enter the bonding mode (the line to the
mouse position from the atom you just clicked on will be your visual cue for the bonding mode).

Next click on the atom you want to make the bond to.

The bond will be created (if possible), and you will revert to the normal select mode.

Make a bond, alternative method

Select the two atoms that you wish to be bonded together.

Select the 'Add Bond' command from the 'Edit' menu or press ctrl-l.

Change the bond type

Select the bond or bonds to change. Use the pop-up menu and choose the required bond type from the
Bond type pull-down menu.

Move an atom (possibly perpendicular to the screen)

First select the atom that you want to move.

Next, translate (middle mouse button, or alt left mouse button), but start with the mouse on the atom that you
want to move.

If you wish to move the atom perpendicular to the screen: use the right mouse button (or command left
mouse button) and move the mouse up or down). This is equivalent to zooming.

Rotate or translate the selection

First make your selection.

Next rotate, translate or zoom as usual, but start with the mouse in the selection. So if you click and drag the
selection, ONLY the selection will be rotated or translated. If you click and drag anywhere else the whole
molecule will be rotated or translated (actually, only your viewpoint).

If you 'zoom' the selection you are really moving the selected objects perpendicular to the screen (in or out
the screen).

Run Script

Save your input using the Save or Save As ... menu commands.
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Your input will be saved in a file with the name you specify, and at the same time a run script will be saved.
It has the same name, but with '.run' appended.

To execute your calculation execute this run script.

You can also use the 'Run' command from the 'File' menu: it will save the run script first, and then execute it
on your local machine, and start ADFtail to follow the execution (showing the logfile).

By default RUNKF (result data) is saved.

If the environment variable SCM_RESULTDIR has been set, the run script will change into that directory.
Next it will run from there, and all result files will be stored in that directory.

If the environment variable SCM_RESULTDIR has not been set, the run script will execute in the directory
where it is started, and the result files will also be located in that place.

Input options remarks

Empty fields

Some input fields do not have a value from the template. In those cases BANDinput does not specify the
value, but leaves the value to be determined by the BAND program.

Coordinates

The coordinates panel shows the coordinates corresponding to the molecule visible in the molecule display.
You may edit the coordinate values here as well.

User Input

You can use the User Input field to specify any kind of text. The text will be appended without any change to
the end of the BAND input. This way, you may access some keys that are not (yet) available in BANDinput.

ADFview
See the ADF-GUI ADFview documentation.

ADFview is used by the BAND-GUI as well as by the ADF-GUI. ADFview uses the .runkf file, which is the
extension of a BAND result file.

BANDstructure

Introduction

BANDstructure shows you a plot of the band structure along a series of lines of high symmetry. The line
elements are separated by vertical gray bars.
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Starting BANDstructure

If you have installed the ADF package correctly, BANDstructure is located in $ADFBIN.

If $ADFBIN is included in your PATH environment variable, you can start the BANDstructure program with
the following command:

bandstructure [filename]

The filename is optional. BANDstructure only handles "RUNKF" files with extension .runkf .

There is a second possibility to start BANDstructure if one of the GUI modules has already been started. All
BAND-GUI modules have the SCM menu on the left-hand side, on most systems represented by a small
SCM logo. Using this SCM menu ADFlevels can be started by selecting the 'BAND Structure' command.

Menu commands

File

Open...

Close the current project and select a new RUNKF file to open.

Save Postscript...

Save the current diagram as a postscript file.

Export to Gnuplot...

Save the current diagram as an input for the gnuplot program. A simple picture can be made in gnuplot with
the command

plot "file.gnuplot" with lines

Quit

Stop and quit BANDstructure.

Options

Show K-points table

Shows information of all the k-points in a table.
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Show All K-Labels

Normally only the label of the begin and and point of the line segments are shown. Enabling this option, it
shows also the labels of the intermediate points, which may become very crowded.

Show Fermi energy

Show or hide the Fermi level indicated with a red line.

Unit

Set the energy unit to your liking.

Help

Provide quick access to the documentation on the SCM website.

Pop-up menus

You activate pop-up menus by pressing the (left) mouse button on an object, and keep the mouse button
pressed down for some time until the menu pops up.

Interactive 3D Brillouin zone display

The bottom half shows the Brillouin zone and the high symmetry lines. Using this tool might give you a more
intuitive feel how the plot runs through the Brillouin zone, than from the plain k-points table.

Rotate/Zoom

This works just the same as in other GUI modules such as bandinput, and adfview.

Selecting line segments

You can click on the lines in the 3D display. The corresponding line segment in the plot will get a gray
background. You can also click in the plot to achieve the same thing.

ADFmovie
See the ADF-GUI ADFmovie documentation.

For BAND it can handle .logfile and .runkf files, and is used to display the progress of a geometry
optimization.
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ADFtail
See the ADF-GUI ADFtail documentation.

ADFtail is used by the BAND-GUI as well as by the ADF-GUI. ADFtail opens the .logfile file, and update it
while the text file grows. The progress of an BAND (or ADF) calculation is always written to this file.

ADFoutput
See the ADF-GUI ADFoutput documentation.

ADFoutput is used by the BAND-GUI as well as by the ADF-GUI. ADFoutput opens the .out file, which is the
output file generated by a BAND (or ADF) calculation.

ADFdos
See the ADF-GUI ADFdos documentation.

ADFdos is used by the BAND-GUI as well as by the ADF-GUI. For BAND ADFdos opens the .runkf file, and
is used to show the full DOS or partial DOS graphs.
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